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Slide 1 – Opening PowerPoint 2013

PowerPoint can be opened in several different ways.  

· If you are a Windows 8 user, you can hover over the top right corner to bring up the Charms bar.  Then click on the Search Charm and type PowerPoint.  The application icon will appear and you can click on that to open PowerPoint.  This is similar to the search option that is available when you click on the Start button on Windows 7.  The search bar will appear at the bottom.  Type PowerPoint and then wait, your computer will search and return anything related to PowerPoint.  There should be an icon under applications that you can click on.
· If you are in Windows 8 and you are in Metro mode, you can click on the PowerPoint 2013 tile.  This is similar to the desktop in Windows 7.  If you have an icon on the desktop in Windows 7 you can click this to get to PowerPoint

Slide 2 – Backstage

· The backstage appears when you first launch PowerPoint and also when you click on the File tab in the ribbon.
· The backstage is where you go to save your files, open your files, change your PowerPoint options and Share and export your presentations,.
· When you first launch PowerPoint you have a couple of options on the backstage:
· You can view which Windows Skydrive account is currently logged in and/or switch to an alternate account.
· You can view a list of recently opened PowerPoint presentations.
· You can open a PowerPoint Presentation by clicking on Open Other Presentation.
· You can create a new presentation.
· PowerPoint used to open to a Blank presentation by default.  However, now you have the option to create a Blank Presentation, or use a template or theme to create a new presentation
· Another option is to search for online templates and themes.  You can do a keyword search by typing a keyword in the search field, or you can select from one of the pre-defined categories.
· For example, we can click in the keyword field and enter “technology”.
· Then press Enter.
· A whole new list of online templates becomes available.
· If we really like one like “technology tiles design template”, we can hover over the bottom right corner of it and click Pin to List.  That way we don’t have to search for it again.  Now if we click Home, we can see this template has now been added to our default list.
· Something new to this release of PowerPoint is that you can preview the theme or template.  This allows you to see the various subsets of colors and design elements before you begin.
· For example let’s take a look at the Slice theme.  The preview window will appear.  Once we see the preview, if the theme just isn’t working for us, then we can use the previous and next arrows on the sides of the screen to view the next or previous themes.  Let’s click the next button.  This takes us to the Celestial theme.  Not bad, let’s go ahead and select this theme.  We can do this by clicking Create in the bottom right corner.
· Notice that our new presentation has the Celestial theme.  In the previous version of PowerPoint you went to the Themes ribbon to change which theme had been applied to the presentation.  In this version you will navigate to the Design ribbon.  From here we could change the theme to something different.
· On the Design Ribbon there is also a Slide Size button.  You can click this button to convert your slides from Standard Size (4:3) aspect ratio to Widescreen (16:9) aspect ratio.

Slide 3 – Creating New Slides
· There are multiple ways to add slides to your PowerPoint presentation.  My favorite way is using keyboard shortcuts.  The keyboard shortcut for adding slides is CTRL + M.
· Another way to add a slide to a presentation is by clicking the New Slide button on the Home ribbon.
· However, in this release of PowerPoint they have added this same  New Slide button to the Insert ribbon.  I can’t tell you how many times that I intuitively went to this slide to insert new slides in the past.  Now we can!
· In order to demonstrate the next part of our presentation we are going to need some slides, so I am going to add about 5 slides to my presentation.

Slide 4 – Transitions between slides
· Everyone likes transitions and animations.  The bullets flying in from the side, the pages checker boarding to reveal the next slide.  But let’s face it, the transitions have not changed in many years.
· Well now they have.  At last count there were over 40 new slide transitions to choose from.
· To add transitions to a slide, navigate to the Transitions ribbon.  Click the drop down menu to reveal the new Exciting transitions that are available.  Click on one of these transitions to see a demonstration of what they will look like in your presentation.
· To apply a transition to all of your slides, select the transition and then click Apply to All.
· You will now see a  little star next to each slide indicating that there is a transition associated with the slide.

Slide 5 – Insert Images
· Next let’s look at images and clipart
· When you hover over an object placeholder, you will notice that the clipart icon has been replaced with the Online Pictures icon.
· Clipart and pictures are no longer installed with Microsoft Office.  They are all online.  So if we want to insert pictures or clipart from Microsoft’s library, we need to click the Online Pictures icon.
· Let’s find a background image to place on this slide.
· Right click on the title slide and select Format background.
· Notice that instead of a properties box, you now have a Format Background options pane that is docked on the right side of the screen.
· Don’t like it on the right side of the screen, no problem drag and drop it to the left side of the screen until it automatically docks.
· Click the picture or texture fill option.
· You will then be given options for which picture to insert.
· Click the Online option.
· This will bring up a search box.  Your default options are you can search Office.com for clipart, Bing Image Search and the pictures on the SkyDrive of the account that is currently logged in.
· We are going to search Office.com for the keyword “gridiron”
· Because we chose such a specific word, we only got back one image.  If we had searched instead for something like “football” we would have received multiple images.
· Select the image and then click Insert.

Slide 6 – Merging Shapes to create new objects
· Now let’s create a goal post.
· To do this we are going to use multiple shapes
· Click the Insert Menu
· Click Shapes
· Select the magnetic disks shape
· Let’s draw one skinny cylinder and then make two copies of it
· Notice as we drag and drop the cylinders alignment guides come up to help us place the object.
· Let’s line one of them up with the top but move it over
· Then if we drag the other one down a bit you can see that the centering guides come on to help us center the third
· Now let’s draw the bottom of the goal post
· Let’s use the rounded rectangle
· Notice now that we are on the Drawing tools ribbon and the Format area, we can insert shapes from here also by clicking on the icons in the top left corner.
· Now I am going to move the bottom portion of the goal post up just a smidge
· Now I am going to click on an area of the background that doesn’t have any place holders and drag my mouse to lasso the items that make up the goal post.
· With all the items selected, I am going to choose the Format ribbon
· And in the top right corner select Merge Shapes.
· There are several options here so we can hover our mouse to preview and see which one works best for us.
· Let’s select Union.
· Now to change the color of this object
· We can right click and change the fill and the outline color
· Notice when you are changing the color that you now have an Eyedropper option, this is cool as you can select the eyedropper, then hover it over an area of the image that has the color you want to change it to.  A small preview of the color will appear.  If you like it click on it.  This allows you set custom colors that will match your presentation.

Slide 7 – Comments
· Since I am not so sure about this goal post, I am going to put a comment here to ask a friend for feedback.
· To do this, you can click the Review ribbon and then click New Comment.
· When you do this the new Comments pane will be displayed to show you the comments in your presentation.
· It uses the name of the person that the Windows SkyDrive Account is connected to.
· Then if my friend or coworker were to review this presentation they could respond and provide me with feedback without having to place information on the actual slide.
· To hide the comments pane I can click on the Show Comments button on the Review tab or simply close the pane.

Slide 8 – Animations
· Next let’s make the words SuperBowl XLVIII and make them fly through the Goal Post
· Enter the text into the title placeholder.  Then resize the placeholder so that the XLVIII wraps around
· Center the text and make it black
· Right click on the object and choose bring to front
· Then click the animations tab
· Let’s add two animations to this text
· Click Add Animation
· Then select grow and turn
· Next click Add Animation again
· Then select Custom Path under Motion Paths
· Click in the bottom right corner and then drag it through the goal post
· Then press ESC on your keyboard
· Next we want to make sure these two animations play at the same time
· On the animations tab click the Animation Pane
· From the drop down menu next to the motion path, select Start with Previous
· Then click the Preview button
· This will allow you to see the final results

Slide 9 – background music
· What’s a football game without the cheer of the crowd
· Let’s add some background music to our slides
· Click Insert, select Audio
· Then choose Online Audio
· Again you have the Office.com clip art come up
· Search for the word “cheer”
· Choose the clipart “Stadium roar”
· Then click Insert
· You can adjust the volume so that it is in the background and not so loud
· To do this click the Volume button
· And select low
· Then since we want this to be the background on all slides, let’s choose Play in Background.

Slide 10 – saving your presentation
· Last but not least you want to save your presentation
· You now have multiple options for this
· With the integration of your SkyDrive account, you can save to your SkyDrive, your computer, or use one of many add-on products like Save to Box to save to another one of your Cloud accounts.
· For this example we are going to choose to save this presentation to our local computer. File | Save.

Slide 11 – Presenter Mode
· Now the only thing left to do is preview it from Presenter mode and practice giving our presentation.
· To do this you press the Alt key and the function key F5 (alt + F5) on your keyboard.
· The Presenter view comes up.  It has changed just a bit.
· You can now view your instructor notes in the bottom right corner.  Too small to read…adjust the size with the font button in the bottom left corner.
· Use the laser pointer to point out specific itemsor change it to a pen or highlighter
· There is also a timer to allow you to see how long it took you to discuss certain slides.
· Is the Presenter side being displayed on the projected screen and the Presentation view being displayed on your computer, swap displays through the display settings.
· Need to access another application, click Show Taskbar.
· You can even see a preview of the next slide
· Need to black out/white out the screen while you do some group work no problem.
· Need to see a preview of all the slides to see where that missing slide is that you are looking for?  No problem, just click the slide sorter view.  Select the slide and then continue on.
· And to top it all off you can use the zoom feature to zoom in on areas of your presentation just like a Prezi!


Slide 12 – Touch/Mouse Mode
· New to this release of Office is the ability to switch to Touch mode, this spaces out the buttons on the ribbons to make them more easy to navigate when you are using a Windows tablet or Surface.
· To access this option, click on the Customize Quick Access Toolbar button in the top left corner.  Select Touch/Mouse Mode.  This will turn on a new button on the Quick Access toolbar.  Click this button to toggle between Touch and Mouse mode.

Slide 13 – Hide the ribbon
· In Office 2013 you can hide the ribbons.  This is great for people who use tablets as it gives you more area to create your PowerPoints.
· Click the Ribbon Display Options menu in the top right corner.  There are three options:
· Auto-hide Ribbon – this option will automatically hide the ribbon when it is not in use.
· Show Tabs – will display only the tabs in the ribbon and when the tab is clicked it will display the rest of the ribbon with the buttons.
· Show Tabs and Commands – This option will allow you to Show Ribbon tabs and commands all the time.  This would be considered your normal setting.

Slide 14 – Slide Master Guides
· This allows you to turn on guides on all of the slides when you are setting up templates.  To turn them on:
· On the View ribbon, select the Guides checkbox, you will probably also want the Ruler checkbox.
· Then click the Slide Master button in the Master Views section of the View ribbon.
· Right click on the side of the slide and select Grid and Guides
· From the submenu select whether to add vertical or horizontal guides
· Once you have inserted the guide you can right click on it and choose to change the color of the guide
· This will help you in identifying which guide to use in certain areas of your presentation.
· You can also right click on a guide and delete it when you are done setting up your template.



